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Before using this information, be sure to read the general information under the “Notices” 

section on page 79. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

This edition applies to VERSION 4.0, Rational Dashboard and to all subsequent releases and 

modifications until otherwise indicated in new editions. 
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About this manual 
 

Welcome to IBM Rational Dashboard, a powerful tool to measure, analyze and manage 

the complete development lifecycle. 

 

 

Typographical  The following typographical conventions are used in this manual:  

Conventions 
   ________________________________________________________________________ 

   Typeface or Meaning 

    Symbol 

________________________________________________________________________ 

    

   Bold  Book titles, important items, and selectable objects, including 

     buttons and menus. For example: Click Yes to continue. 

 

   Courier  Commands, files, and directories; computer output. For example: Edit 

     your .properties file.  

 

>    A menu choice. For example: Select File > Open. This means select the 

  File menu, then select the Open command from it. 

________________________________________________________________________ 
  

 

 

Related  The following table describes where to find information in the IBM Rational Dashboard  

Documentation documentation set: 

   ________________________________________________________________________ 

   For information on     See 
   ________________________________________________________________________ 

    

   How to install IBM Rational Dashboard  Installation Guide 

   and set up licenses to use it. 

 

Getting Started with  IBM Rational Dashboard  

IBM Rational Dashboard    Online Help 
 

How to use IBM Rational Synergy IBM Rational Synergy 

Walkthrough 

 

How to use IBM Rational DOORS IBM Rational DOORS 

Walkthrough 

________________________________________________________________________ 

 

You will find PDF versions of the manuals on: 

 

 The IBM Rational documentation CD 

 

 Our web site at https://www.ibm.com/software/rational/support/ 
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1 Introduction 
 

This chapter contains the following introduction topics: 

 

 Document Purpose 

 

 Intended Audience 

 

 Document Organization  

 

 

 

Document 
Purpose  

The document provides technical information required to install IBM Rational Dashboard.  

The IBM Rational Dashboard Installation Guide walks users through the process of installing 

the following components: IBM Rational Dashboard Portal, IBM Rational Dashboard Tools 

and IBM Rational Dashboard Web Services. 

 

The instructions provided in Section 4 of this document are for a full setup, often called a 

“clean install”, of IBM Rational Dashboard onto a Windows computer.  These instructions are 

intended for a computer where IBM Rational Dashboard has not been previously installed.   

 

For instructions on updating from a previously installed version of IBM Rational Dashboard, 

please see Section 6 Updating Prior Version.  

 

 

Intended 
Audience 

The installation document is intended for IBM Rational Dashboard administrators, 

integrators, software developers, programmers and installers.  The reader of this document 

will be directly involved in installing, configuring, verifying and administering the operation 

of IBM Rational Dashboard and the associated system, database and network resources.  

 

 

Document 
Organization 

This document is organized in the following sections: 

 

Section 1 – Introduction  

Section 2 – Overview 

Section 3 – Prerequisites 

Section 4 – Application Installation and Licensing 

Section 5 – Installing LDAP Membership Provider 

Section 6 – Updating Prior Version 

Section 7 – Test Installation 

Section 8 – Troubleshoot Installation 

Section 9 – Un-Install IBM Rational Dashboard 

Section 10 – Contact Information 

Section 11 – Notices  
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2 Overview 
 
IBM Rational Dashboard Installer allows users to install one, two or all three components. 

This chapter contains a description of each IBM Rational Dashboard component: 

 

 IBM Rational Dashboard Windows Tools 

 

 IBM Rational Dashboard Portal 

 

 IBM Rational Dashboard Web Services 

 

 

 

Dashboard 
Windows Tools 

IBM Rational Dashboard Tools is a collection of Windows applications including the IBM 

Rational Dashboard Collector, User Sync Utility and Exchanger. The IBM Rational 

Dashboard Collector is a Windows application used to collect data from various sources 

including IBM Rational DOORS, IBM Rational Change and IBM Rational Synergy.  The 

Collector uses Web Services to connect to the IBM Rational Dashboard Portal.  The IBM 

Rational Dashboard Collector can be installed and run on any machine that has an existing 

DOORS and/or Synergy client and can also be installed on multiple machines. No license is 

required for IBM Rational Dashboard Collector.  

 

 

Dashboard 
Portal 

IBM Rational Dashboard Portal is the web application used to view, manage and configure 

projects/units, and graphs within them.  IBM Rational Dashboard Portal runs in Microsoft IIS 

and uses .NET Framework.  IBM Rational Dashboard Portal requires a license and can only 

be installed once per license. 

 

 

 

Dashboard 
Web Services 

IBM Rational Dashboard Web Services are web-based services that connect IBM Rational 

Dashboard Collector and IBM Rational Dashboard Portal.  Web Service implementation 

allows IBM Rational Dashboard Collector to be installed on a different server than IBM 

Rational Dashboard Portal.  Web Services have a distinct set of methods that retrieve 

information required by IBM Rational Dashboard Collector and IBM Rational Dashboard 

Portal.  Web Services process data collected by IBM Rational Dashboard Collector and 

inserts the data into database tables for querying by IBM Rational Dashboard Portal.  IBM 

Rational Dashboard Web Services run in Microsoft IIS and use .NET Framework. Only one 

installation of IBM Rational Dashboard Web Services is required for multiple IBM Rational 

Dashboard Portal licensed users.  
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3 Prerequisites 
 
All prerequisites are required for proper IBM Rational Dashboard installation. 

This chapter contains the following IBM Rational Dashboard prerequisite requirements: 

 

 IBM Rational Dashboard Windows Tools Requirements 

 

 IBM Rational Dashboard Portal Requirements 

 

 IBM Rational Dashboard Web Services Requirements 

 

 

IBM Rational  
Dashboard 
Windows Tools 
Requirements 

Recommended hardware configuration: 

 AMD/Intel 3 GHz or AMD/Intel 64 Bit Processor 

 1 GB of Physical RAM  

 100 MB of free disk space 

 

Supported Operating Systems: 

 Windows Vista 

 Windows XP Professional SP2 

 Windows Server 2003  

 

.NET Framework 2.0 is required 
 

IBM Rational DOORS/IBM Rational Synergy clients must be available on the machine where 

the IBM Rational Dashboard Collector is installed. 

 

 

 

IBM Rational  
Dashboard 
Portal 
Requirements 

 

Recommended hardware configuration for a system running up to 50 IBM Rational 

Dashboard Portal concurrent users: 

 Intel Dual Processor or AMD/Intel 64 Bit Processor  

 4 GB of RAM  

 500 MB of free disk space 

 

 

After the initial 50 users, add 1 GB of RAM for each additional 25 users that are expected to 

be online concurrently. For example, 100 concurrent users, require 6GB of RAM.  



 
© Copyright IBM Corp. 2004, 2009   

 

 

|8 

Supported Windows Operating Systems: 

 Windows XP Professional (test and demonstration only – not production) 

 Windows Vista (test and demonstration only – not production) 

 Windows Server 2003 (production) 

 

Required System Components (must be installed prior to installing IBM Rational Dashboard): 

 .NET Framework 2.0 

 Microsoft SQL Server (2005 or 2008)  -- Microsoft SQL Server Express (2005 or 2008) 

can be used for test or demonstration purposes 

 Microsoft SQL Server Management Studio – Must be installed on the machine where the 

IBM Rational Dashboard installation is being run.  The Configuration Utility (run during 

the installation) requires support files (the SMO DLLs) from the SQL Management 

Studio to function correctly. 
 Windows account with permissions to create users and databases in SQL - In order to run 

the configuration utility, which creates and configures the database, the Windows account 

used to run the install must be able to create users and databases in SQL. 

 Internet Information Server version 5, 6, or 7 

 

 

Please see the section titled “Planning a SQL Server Database” for information on how to 

configure either Microsoft SQL Server or Microsoft SQL Server Express with IBM Rational 

Dashboard.  

 
 

 

IBM Rational  
Dashboard 
Web Services 
Requirements 

IBM Rational Dashboard Web Services must be installed on the same computer as IBM 

Rational Dashboard Portal.  

 

Recommended hardware configuration for a system running up to 50 IBM Rational 

Dashboard Portal concurrent users: 

 Intel Dual Processor or AMD/Intel 64 Bit Processor  

 4 GB of RAM  

 500 MB of free disk space 

 

After the initial 50 users, add 1 GB of RAM for each additional 25 users that are expected to 

be online concurrently. For example, 100 concurrent users, require 6GB of RAM.  

 

Supported Windows Operating Systems: 

 Windows XP Professional (test and demonstration only – not production) 

 Windows Vista (test and demonstration only – not production) 

 Windows Server 2003 (production) 

 

Required System Components (must be installed prior to IBM Rational Dashboard Web 

Services): 

 .NET Framework 2.0 

 Internet Information Server version 5, 6, or 7 
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Planning a  
SQL Server  
Database 

 

IBM Rational Dashboard requires either a Microsoft SQL Server or Microsoft SQL Server  

Express database server.  This chapter explains installation and configuration requirements for 

the database server. If your organization already has a SQL Server database server already 

configured, the IBM Rational Dashboard may be configured to use that server. You should 

review this section with your database administrator to see if using an existing database server 

is practical. 

 

SQL Server and SQL Server Express are products available from Microsoft. Information on 

planning, installing, configuring, securing and maintaining the software is available from their 

website. In addition, SQL Server Express is available for download from the Microsoft web 

site at no cost. SQL Server Express contains connection, performance and capacity 

restrictions not present in SQL Server. You should review the SQL Server Express product 

information on the Microsoft web site to determine if it meets your business needs. 

  

When installing either version of SQL Server, you must complete the following prior to 

installing the Portal software: 

 Install SQL Server or SQL Server Express database and set the security to mixed 

mode, which enables Windows Authentication as well as named SQL users.  

 Install SQL Server Management Studio Client tools on the same machine as the 

Portal and Web Services. The Portal Installer uses these client tools to install a new 

database and to update existing ones. 

If you are using Microsoft SQL Server Express, you must enable network communication 

protocols for the SQL Server Express instance.  The network communication protocols are 

disabled by default. 

 

Also, when using SQL Server Express, you should configure a named instance of the 

database. SQL Server Express allows you to select either a default instance or a named 

instance. It is recommended that a named instance be used with IBM Rational Dashboard to 

simplify the configuration of the database when more than one instance is installed. (Other 

applications using SQL Server Express will use their own named instances.)  
 

 

 

 

SQL Server  
Express Setup  

 

This section provides guidance for installing Microsoft SQL Server Express 2005.  These 

instructions will also work with Microsoft SQL Server Express 2008.  When the SQL Express 

setup application is started, you will be prompted for your name and the name of your 

company.  

 



 
© Copyright IBM Corp. 2004, 2009   

 

 

|10 

Notice the checkbox for “Hide advanced configuration options.” Make sure you CLEAR 

THIS CHECKBOX so that the advanced options are not hidden.  This is necessary in order 

to configure a named instance of the database. 

 

 

 
 

 

Select the Next button to continue to the Feature Selection screen. 
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Make sure both the Database Services and Client Components options are selected to be 

installed.  Select the Next button to continue to the Instance Name screen. 
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On the Instance Name screen, you will be prompted for the type of instance to use for your 

new SQL Express database. This is either default or named. For IBM Rational Dashboard, it 

is recommended that you select a named instance and name the instance “SQLExpress”.  

 

  
 

 

Select Next to continue to the Authentication Mode screen. 
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Select the Mixed Mode option, as the Windows Integrated security mode (for SQL Express 

2005) is not supported.  Specify the sa logon password and select Next to continue. 

 

 

 
 

 

The default selections are acceptable for the remaining screens of the SQL Server 2005 

Express Setup.  Once the „Ready to Install‟ screen appears, select the Install button to install 

SQL Server 2005 Express. 
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4 Application Installation and Licensing 
 

This chapter contains the following application installation topic: 

 

 Run IBM Rational Dashboard Installation 

 IBM Rational Dashboard License Interface 

 

 

 

Run    

IBM Rational  
Dashboard 
Installation 
 The Setup Application will guide you through the following steps: 

 

 Welcome Screen        

 IBM Rational Dashboard Portal Installation 

 IBM Rational Dashboard Web Services Installation 

 IBM Rational Dashboard Windows Tools Installation 

 

                                    ___________________________________________________________________________ 

 

It is strongly recommended that you exit all Windows programs before running this setup 

program.   

___________________________________________________________________________ 

 

___________________________________________________________________________ 

 

It is strongly recommended that you backup all databases associated with IBM Rational 

Dashboard if you had a previous IBM Rational Dashboard installation. 

_______________________________________________________________ 

 

                                    Start IBM Rational Dashboard Setup Application, follow these steps:   

 
1. Exit all Windows Applications before running the installers 

 

2. Unzip the archive and open the Setup.html file.   



 
© Copyright IBM Corp. 2004, 2009   

 

 

|15 

 

3. Click the Dashboard Portal link on the Welcome screen to install the IBM Rational 

Dashboard Portal or View license agreement to review the licensing agreement.  
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4. Click Next on the Welcome screen for the IBM Rational Dashboard Portal Installation or 

Cancel to exit the installation. 
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__________________________________________________________________________ 

 
 

IBM Rational Dashboard Portal Installation requires users to accept the terms of the End User 

License Agreement. The End User License Agreement can be reviewed by selecting the View 

License Agreement button on the License Agreement screen.  

__________________________________________________________________________ 

 

5. Select the „View License Agreement‟ button to review the software license and support 

agreement.   

 

6.  Select the I accept the license agreement radio button and click Next to accept the 

agreement and proceed.  

 

7. If you do not accept the license agreement, click Cancel to exit the Setup Application. 
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8. Click on the Browse button to select or enter a folder name where the Portal will be 

installed.  

 

9. Click Next to continue IBM Rational Dashboard Portal Installation. 
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10. The next screen introduces IIS configuration for the IBM Rational Dashboard Portal. 

 

11. Click Next to continue IBM Rational Dashboard Portal Installation, Back to return to the 

Destination Folder Screen or Cancel to exit the installation. 
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12. Select the Web Site where the virtual directory for the IBM Rational Dashboard Portal 

will be located.  If you do not have multiple existing IIS Web Sites, this step will not be 

included in the installation and the virtual directory will be created under the Default 

Web Site. 

 

13. Select the Next button to continue with the installation of IBM Rational Dashboard 

Portal. 
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14. Enter a Virtual Directory Name.  This will become part of the web address used to 

access the Portal.  For example, a virtual directory named “Dashboard” will become 

http://server/Dashboard/Default.aspx”.  Unless the name “Dashboard” conflicts with an 

application already installed, it is recommended that you do not change this name.  

 

15. Select the Virtual Directory Parent. This option, for advanced installations only, allows 

the IBM Rational Dashboard Portal virtual directory to be placed inside another/existing 

virtual directory to inherit settings and permissions.  It is recommended that you leave 

this field blank. 

 

16. Select the Physical Directory.  This will be assigned as the Local Path in the virtual 

directory.  When connecting to the virtual directory, all content will come from this 

location.  It is recommended that you do not change this path unless you have modified 

the destination location for the IBM Rational Dashboard Portal installation. 

 

17. Click Next to continue IBM Rational Dashboard Portal Installation.  
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18. Click Next to continue IBM Rational Dashboard Portal Installation, Back to return to the 

New Virtual Directory Screen or Cancel to exit the installation. 

 

 
 
 

Note: 

 

During installation on Vista, the installer briefly displays a command window after the Next 

button is pressed.  
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WARNING: If you are planning to connect to an existing IBM Rational Dashboard database 

which does not need to be updated, select the Exit button on the IBM Rational Dashboard 

Configuration Utility window and skip the following steps for database creation and 

configuration.  This applies to reinstallations of current software. 

______________________________________________________                                    

 ___________________________________________________________________________ 

 

The IBM Rational Dashboard Configuration Utility provides default suggestions for all 

information requested.  You may customize this information by entering alternate 

information.  If you choose not to use the default suggestions, note the customized 

information for future reference. Setup information will be necessary for support assistance.                         

___________________________________________________________________________ 

 

 

19. If you are installing a new database for this IBM Rational Dashboard installation, select 

the Install New Database button.  If you are planning to use an existing IBM Rational 

Dashboard database (installed with a prior version), select the Update Existing Database 

button and skip to step 32. 
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20. If you are using Microsoft SQL Server (developer, professional, standard or enterprise 

editions), enter only the server name of the computer hosting your SQL database. 

If you are using Microsoft SQL Server Express, always check the “I am using SQL 2005 

Express or 2008 Express" checkbox. 

_____________________________________________________________________ 
     

        The server name may not contain a colon “:” or an underscore “_” . 

_____________________________________________________________________ 
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21. SQL Server users should skip this step. If you are using the default instance of 

Microsoft SQL Server Express, leave the instance name blank. Enter the instance name 

only if you installed a named instance of Microsoft SQL Express.  

_____________________________________________________________________ 

 

Note- Mouse over “I am using SQL 2005 Express or 2008 Express” for the following 

tool tip: How to Check Default Versus Named Instance.  Use SQL Server Management 

Studio to check connection parameters.  If you connect with the COMPUTER name, then 

you have a default instance.  If you connect with the COMPUTER\INSTANCE, then you 

have a named instance. 

_____________________________________________________________________ 

 

                               

 
 

22. Click the “>>” button to continue or the Exit button to cancel the Configuration Utility. 
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23. Enter the names for the Portal and Transform Databases or accept the default names.  The 

names entered in the fields will be used as the names for the two databases created by the 

Configuration Utility.  Normally these databases do not exist. 

 

24. If a database currently exists, check the “Delete/drop the databases and re-create 

them?” checkbox.   

_____________________________________________________________________ 
     

        Note- checking this box permanently deletes the previous database. Creating a back up 

database is recommended before deleting and recreating the database. 

       _____________________________________________________________________ 

 

25. Click the “>>” button to continue.  The “<<” button will return you to the server 

selection tab and the Exit button will cancel the database installation. 
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26. Enter text for a SQL Server Username and associated Password.  If the Create the SQL 

named user if it does not exist checkbox is checked, the Configuration utility will create 

a new user in both databases (specified in tab 2) and configure login security in both 

databases. Your Windows login (for the user running the installation) must have 

permission to create a user in the database server (specified in tab 1). If the username 

already exists, then uncheck the Create the SQL named user if it does not exist option. 
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27. Depending on your database and network security, you may need to over-ride the default 

connection string. To do this, click on the checkbox marked “I need to override the 

default connection strings to my database.” In the two text boxes, you need to enter 

two connection strings: the first connection string is used to check, drop (optionally) and 

create the databases; the second connection string is used to configure each database. 

Notice that the second string must have the text “{0}” which is replaced with a database 

name before use. 

 

 
 

28. Click “>>” to continue, “<<” to return to the previous screen or Exit to cancel the 

database installation. 
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29. Review the server, database, and user details prior to continuing and note all changes to 

the default information for future reference. This information will be necessary when 

requesting troubleshooting assistance. 

 

30. Click Perform Setup “>>” to continue the installation, “<<” to return to the previous 

screen or Exit to cancel the database installation. 
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31. The Results tab verifies each step of the installation process. A time stamp labeled 

Finished will verify that the installation has completed. Verify the installation finished 

with no errors, select the Finish button to complete the IBM Rational Dashboard 

Database installation and skip to step 44.   
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32. For an existing database update, if you are using Microsoft SQL Server (developer, 

professional, standard or enterprise editions), enter only the server name of the computer 

hosting the IBM Rational Dashboard database to be updated. 

If you are using Microsoft SQL Server Express, always check the “I am using SQL 2005 

Express or 2008 Express" checkbox. 

_____________________________________________________________________ 
     

        The server name may not contain a colon “:” or an underscore “_” . 

_____________________________________________________________________ 
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33. Microsoft SQL Server users should skip this step. If you are using the default instance 

of Microsoft SQL Server Express, leave the instance name blank. Enter the instance 

name only if you installed a named instance of Microsoft SQL Express.  

_____________________________________________________________________ 

 

Note- Mouse over “I am using SQL 2005 Express or 2008 Express” for the following 

tool tip: How to Check Default Versus Named Instance.  Use SQL Server Management 

Studio to check connection parameters.  If you connect with the COMPUTER name, then 

you have a default instance.  If you connect with the COMPUTER\INSTANCE, then you 

have a named instance. 

_____________________________________________________________________ 

 

 
 

34. Click the “>>” button to continue or the Exit button to cancel the Configuration Utility. 
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35. Enter the name for the IBM Rational Dashboard Portal Database to be updated.   

36. Click the “>>” button to continue.  The “<<” button will return you to the server 

selection tab and the Exit button will cancel the database update. 
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37. Enter the login name and password of the existing account for the IBM Rational 

Dashboard database on the SQL Server.  This account must have permissions to modify 

the database schema. 
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38. Depending on your database and network security, you may need to over-ride the default 

connection string. To do this, click on the checkbox marked “I need to override the 

default connection strings to my database.” In the two text boxes, you need to enter 

two connection strings: the first connection string is used to check, drop (optionally) and 

create the databases; the second connection string is used to configure each database. 

Notice that the second string must have the text “{0}” which is replaced with a database 

name before use. 

 

 
 

39. Click “>>” to continue, “<<” to return to the previous screen or Exit to cancel the 

database update. 
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40. Review the server, database, and user details prior to continuing and note all changes to 

the default information for future reference. This information will be necessary when 

requesting troubleshooting assistance. 

 

41. Click “Perform Setup >>” to continue the installation, “<<” to return to the previous 

screen or Exit to cancel the database update. 
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42. The Results tab verifies each step of the update process. A time stamp labeled Finished 

will verify that the update has completed. Verify the update finished with no errors and 

select the Finish button to complete the IBM Rational Dashboard Database update. 
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43. The IBM Rational Dashboard Portal has been successfully completed.  Click the Finish 

button to exit the Portal installation and return to the Welcome screen for the IBM 

Rational Dashboard Installer. 
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44. Click the Dashboard Web Services link to install IBM Rational Dashboard Web 

Services or View license agreement to review the licensing agreement.  
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45. Click Next on the Welcome screen for the IBM Rational Dashboard Web Services 

Installation or Cancel to exit the installation. 
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__________________________________________________________________________ 
 

IBM Rational Dashboard Web Services Installation requires users to accept the terms of the 

End User License Agreement. The End User License Agreement can be reviewed by selecting 

the View License Agreement button on the License Agreement screen. 

__________________________________________________________________________ 

 

46. Select the „View License Agreement‟ button to review the software license and support 

agreement.  

 

47.  Select the I accept the license agreement radio button and click Next to accept the 

agreement and proceed.  

 

48. Click Cancel to exit the Setup Application. 
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49. Select the destination folder for the IBM Rational Dashboard Web Services Setup by 

clicking the Browse button.  Move to the next step if you are installing to the default 

location. 

 

50. Click Next to continue IBM Rational Dashboard Web Services Installation. 
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51. The next screen introduces IIS configuration for Web Services.  

 

52. Click Next to continue IBM Rational Dashboard Web Services Installation, Back to 

return to the Destination Folder Screen or Cancel to exit the installation. 
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53. Select the Web Site where the virtual directory for the IBM Rational Dashboard Web 

Services will be located.  If you do not have multiple existing IIS Web Sites, this step 

will not be included in the installation and the virtual directory will be created under the 

Default Web Site. 

 

54. Select Next to continue with the installation of the IBM Rational Dashboard Web 

Services. 
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55. Enter a Virtual Directory Name.  This will become part of the web address used by 

client applications to access Web Services. Unless the name “DashboardWS” conflicts 

with an application already installed, it is recommended that you do not change this 

name.  

 

56. Select the Virtual Directory Parent. This option, for advanced installations only, allows 

the IBM Rational Dashboard Web Services virtual directory to be placed inside an 

existing virtual directory to inherit settings and permissions.  It is recommended that you 

leave this field blank. 

 

57. Select the Physical Directory.  This will be assigned as the Local Path in the virtual 

directory.  When connecting to the virtual directory, all content will come from this 

location.  It is recommended that you do not change this path unless you have modified 

the destination location for the IBM Rational Dashboard Web Services installation.  

 

58. Click Next to continue with the installation.  
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59. Click Next to start the installation. Click Back to modify settings on previous pages. 

Click Cancel to terminate the installation. 

 

 
 

Note: 

 

During installation on Vista, the installer briefly displays a command window after the Next 

button is pressed.  
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60. The IBM Rational Dashboard Web Services installation has been successfully completed.  

Click the Finish button to exit the IBM Rational Dashboard Web Services installation 

and return to the Welcome screen for the IBM Rational Dashboard Installer. 
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61. Click the Dashboard Windows Applications link to install the IBM Rational Dashboard 

Windows Tools or View license agreement to review the licensing agreement.  
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62. Click Next on the Welcome screen for the IBM Rational Dashboard Windows Tools 

Installation or Cancel to exit the installation. 

 

 



 
© Copyright IBM Corp. 2004, 2009   

 

 

|50 

        __________________________________________________________________________ 
 

IBM Rational Dashboard Windows Tools Installation requires users to accept the terms of the 

End User License Agreement.  The End User License Agreement can be reviewed by 

selecting the View License Agreement button on the License Agreement screen. 

__________________________________________________________________________ 

 

63. Select the View License Agreement button to review the software license and support 

agreement. 

 

64.  Select the I accept the license agreement radio button and click Next to accept the 

agreement and proceed.  

 

65. If you do not agree with the license, click Cancel to exit the Setup Application. 
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66. Select the IBM Rational Dashboard Windows Tools that you would like to install on the 

system. 

 

67. Select the destination folder for the IBM Rational Dashboard Windows Tools Setup by 

clicking the Browse button.  Move to the next step if you are installing at the default 

location. 

 

68. Click Next to continue IBM Rational Dashboard Windows Tools Installation. 
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69. Click Next to continue IBM Rational Dashboard Windows Tools Installation, Back to 

return to the Destination Folder Screen or Cancel to exit the installation. 
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70. The IBM Rational Dashboard Windows Tools installation has been successfully 

completed.  Click the Finish button to exit the IBM Rational Dashboard installation. 

 

                                   

 
 
 

 

Post Installation  
Notes 

If you have installed IBM Rational Dashboard to a drive other than C:\, the following 

additional steps will need to be performed in order for all sections of IBM Rational Dashboard 

to work as expected. 
 

1. Copy the Business Objects folder to the drive where IBM Rational Dashboard is 

installed.  The tools necessary to run the Crystal Reports contained in the IBM Rational 

Dashboard Reports tab are installed by default to C:\Program Files\Business Objects.   

 

2. Update the IBM Rational Dashboard Web Services web.config portal location.  The drive 

for the selected portal installation location defaults to the C:\ drive.  The Web Services 

web.config file is located by default at C:\Program Files\IBM\Rational\Dashboard\ 

WebServices\web.config 
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IBM Rational  
Dashboard 
License 
Interface 

After installing IBM Rational Dashboard, it is necessary to apply a license using the IBM 

Rational Dashboard License Interface in order to access the software.  The steps to apply a 

license are as follows: 
 

1. Start the IBM Rational Dashboard License Interface. 

 

Start > Programs > IBM > Rational > Dashboard > Dashboard Licensing Utility 

 

2. Click “…” button to select the folder location of your IBM Rational Dashboard 

web.config file. 

 

Default location: C:\Program Files\IBM\Rational\Dashboard\Portal 

 

3. Click “…” button to select the file that contains your IBM Rational Dashboard license 

(FlexNet license file) 

 
             

 

4.  Click Check and Update License to update IBM Rational Dashboard with your 

current license file. 

 

5.  Click Exit to close the IBM Rational Dashboard License Interface.  
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5 Installing LDAP Membership Provider 

 

This chapter contains the following information on installing the LDAP Membership 

Provider. 

 

 Pre-Requisites for LDAP Membership Provider 

 

 Configuring the Dashboard Portal to use LDAP 

 

 

 
Pre-Requisites 
 

The LDAP Membership provider allows users to enter LDAP accounts and passwords when 

logging into the IBM Rational Dashboard Portal. Because Dashboard is an ASP.NET 

application, it uses a built-in mechanism, called a membership provider, to authenticate 

against external lists of users (such as LDAP). The IBM Rational Dashboard LDAP 

Membership provider is an add-on which uses the membership provider mechanism of 

ASP.NET. 

Before installing the LDAP membership provider, you should ensure that:  

 

 IBM Rational Dashboard has been installed and configured correctly.  

 

 An IBM Rational Dashboard Administrator account exists and can access the Admin tab 

login in order to create and modify accounts 

 

 An LDAP server (Apache Directory Server or Sun One) has been installed and 

configured. 

 

 

The LDAP Membership Provider is provided as a single DLL file. The IBM Rational 

Dashboard installer automatically copies this file into the Portal‟s \Bin subfolder. 

 

 

Configuring the 
Portal to Use the 
LDAP Membership 
Provider 
 

Login authentication for the IBM Rational Dashboard Portal is configured via a web.config 

file, located in the Portal‟s root folder. The web.config file can be modified using a text 

editor. You may also use an XML editor, many of which identify comments and provide 

features which make editing easier.  

 

To configure the Portal to use LDAP, follow these steps in the indicated order:  

1. Configure a Dashboard Administrator account for LDAP login 

2. Disable Windows and other types of authentication  

3. Enable forms authentication using the LDAP membership provider  
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4. Enter your site‟s LDAP server information 

5. Login to LDAP 

 

If you do not perform the first step, you will not be able to modify or configure your site after 

switching to LDAP (since no accounts will have been configured to use LDAP) and you will 

have to switch back to Windows authentication. 

 

Configure an Administrator Account for LDAP Login: 

 

On the Admin tab of the Portal, you should create a new account, or modify an existing 

account such that the account allows an LDAP user to access the portal with an administrator 

license. To make this change, select the “Admin” tab and then click on the “Accounts” 

command from the left-hand side navigation bar. You can then select the “Edit” button 

corresponding to the account you wish to modify, or select the “Add” button to create a new 

one.  

 

In the following figure, the page which allows editing a user is shown. The account field is 

filled in with “ldapadmin” which is the id of a user which has previously been defined in the 

LDAP server. (Note that when using a Windows authentication, the account field would be 

filled in with an account of the form DOMAIN\username.) 

 

 
 

Once you have made the appropriate changes, press the “save” button to save and return to the 

previous screen. 
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Disable Windows Authentication: 

 

After installation, the Portal web.config file is configured for Windows authentication via two 

lines in the <system.web> section.  The default location for the web.config file is C:\Program 

Files\IBM\Rational\Dashboard\Portal\web.config.  To disable Windows authentication, make 

the changes shown below:  

 

(before)  

<authentication mode="Windows"/> 

 <identity impersonate="true"/> 

(before)  

 

To turn off Windows authentication, you can comment the lines out using the XML comment 

syntax: 

 

(after) 

 <!--  

<authentication mode="Windows"/> 

 <identity impersonate="true"/> 

--> 

(after)  

 

Note that the XML comments start with “<!” and then two hyphens. XML comments end 

with two hyphens and then “>”. 

 

Once the above changes are made, be sure to save your changes. 

 

 

Enable Forms Authentication Using LDAP Membership: 

 

Immediately after the changes made above, enter the following text into the web.config file. 

Notice that the forms authentication options (for both non-SSL and SSL) are entered 

immediately after the windows authentication options which were commented out in the last 

section. 

 

 

Example of Web.config for Non-SSL LDAP: 

 

The following example provides a sample of configuring a non-SSL connection from IBM 

Rational Dashboard to an LDAP server. 

 

 (after) 

<!--  

<authentication mode="Windows"/> 

 <identity impersonate="true"/> 

--> 

 

<authentication mode="Forms"> 

<forms loginUrl="App_UI/Misc/Login.aspx"  

  name=".DashAuth"  

    path="/"  

  defaultUrl ="Default.aspx" /> 

</authentication> 

<authorization> 

<deny users="?" /> 

<allow users ="*"/> 
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</authorization> 

 

<membership defaultProvider="LdapMembershipProvider"> 

<providers> 

  <add name="LdapMembershipProvider" 

   type="Distributive.Security.LdapProvider, LdapMembership,  

               Version=1.0.0.0, Culture=neutral " 
ldapServer="localhost" 
ldapPort="389"  

ldapDn="ou=system" 

ldapUseSSL="false"  

ldapProperty="uid" 

ldapCertificate="none"  /> 

 </providers> 

</membership> 

(after) 

 

Once these changes are made, save the web.config file. 

 

 

Example of Web.config for SSL (Secure Mode) LDAP: 

 

The following example provides a sample of configuring a SSL connection from Dashboard 

to an LDAP server. 

 

 (after) 

<authentication mode="Forms"> 

<forms loginUrl="App_UI/Misc/Login.aspx"  

  name=".DashAuth"  

    path="/"  

  defaultUrl ="Default.aspx" /> 

</authentication> 

<authorization> 

<deny users="?" /> 

<allow users ="*"/> 

</authorization> 

 

<membership defaultProvider="LdapMembershipProvider"> 

<providers> 

  <add name="LdapMembershipProvider" 

   type="Distributive.Security.LdapProvider, LdapMembership,  

               Version=1.0.0.0, Culture=neutral " 
ldapServer="localhost" 
ldapPort="636"  

ldapDn="ou=system" 

ldapUseSSL="true"  

ldapProperty="uid" 

ldapCertificate="x509cert.cer"  /> 

 </providers> 

</membership> 

(after) 

 

 

Make sure that the double quotes are simple (straight down) double quotes and not open and 

close quotes (which are automatically created by word processing programs such as Microsoft 

Word) 
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The case of the attribute names is important. For example, you must enter “ldapServer” 

and not “ldapserver” or “LdapServer”. 

 

Once the above changes are made, be sure to save your changes. 

 

 

Enter LDAP Server Information: 

 

The LDAP membership provider must be configured in the <membership> section of the 

web.config file. All attributes are shown in the following table. 

 

Attribute Description Default 

ldapServer The ip address or name of the LDAP server.  

ldapDn The distinguished name within the LDAP server where the 

user list is located 

 

ldapPort The port number of the LDAP server.  “389” 

ldapProperty The property retrieved during login which is compared to 

the user name entered into the Portal login page.  

“uid” 

ldapUseSSL Either “false” or “true”, indicating that the LDAP server 

uses SSL.  

“false” 

ldapCertificate The drive, folder and file name of an X509 certificate used 

by the LDAP server. If no certificate checking is required, 

you may enter the value “none”.  

“none” 

 

The first two, ldapServer and ldapDn, are required. The ldapPort is optional and should be 

changed if the port number is not 389. While the ldapProperty is also optional, in most cases 

you will need to ask your LDAP administrator for the name of the property which contains 

the users login name.  

 

Notes: 

The case of the attribute names is important. For example, you must enter “ldapServer” -- 

not “ldapserver” or “LdapServer”. 

 

You must enter values for the ldapServer property and ldapDn (distinguished name) property. 

These are the first two rows in the table above and highlighted in yellow in the previous 

example.  

 

It is imperative that you enter the string “LDAP://” in all upper case letters and not in any 

other form. (For example “ldap://” will not function correctly.) 

 

Windows folder and file security must be set to allow the account being used for the Portal 

ASP.NET application pool (for example, the ASPNET worker process) to access the 

certificate file specified by the ldapCertificate property.  

 

If the file specified in the ldapCertification property does not have a folder name, then the file 

must be located in the Portal \bin subfolder. Otherwise, you should include a full path, drive 

and folder, for the file. 
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Login to LDAP: 

 

Once the previous steps are completed, your EXPRESS portal will display a login window as 

shown in the following figure. Users must enter the LDAP account name and password to 

login. 

 

 
 

If a configuration error occurs, please check the Portal log file, located in the \Logs 

subfolder of the Portal. Additional information, depending on the type of error, may be 

available in the System Event log. 
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6 Updating Prior Version 

 

 

This chapter contains the following information on updating prior versions. 

 

 Pre-Update Instructions 

 

 Removing Prior IBM Rational Dashboard Versions 

 

 Installation of IBM Rational Dashboard 

 

 

 
Pre-Update 
Instructions 

Prior to beginning the process of updating the current installation of IBM Rational Dashboard, 

perform the following steps in order to facilitate the final installation steps. 

1. Save the Portal web.config file to another location in order to verify the connection string 

for the database is correct after the update process is complete.  The web.config file is 

located by default at C:\Program Files\Telelogic\Dashboard\Portal 

2. Save the collector.set file to another location in order to save all currently created 

Collector sources.  The collector.set file is located by default at C:\Program 

Files\Telelogic\Dashboard\Collector 

3. Save the .bin files containing the collection details.  The files are located by default at 

C:\Program Files\Telelogic\Dashboard\Portal\Logs   

4. Backup all existing databases that are used by IBM Rational Dashboard.  The default 

databases are Dashboard and Transform. 

 

 

Removing 
Prior IBM Rational 
Dashboard 
Versions 

It is necessary to remove any previously installed version of Telelogic Dashboard before 

beginning the installation process for IBM Rational Dashboard version 4.0.0.  The steps 

to complete the removal of Telelogic Dashboard are detailed below. 

 

To remove Telelogic Dashboard Portal: 

 

1.    Log into the machine as an Administrator user where Telelogic Dashboard Portal is 

installed. 

 

2.    Open the Add or Remove Programs window (Start > Control Panel > Add or 

Remove Programs). 

 

3.    Select Telelogic Dashboard from the list of options. 
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4.    Select Remove/Uninstall. 

  

5.    Delete the Portal folder (C:\Program Files\Telelogic\Dashboard\Portal) and all of its 

subfolders. 

 

 

To remove Telelogic Dashboard Web Services: 

 

1.    Log into the machine where Telelogic Dashboard Web Services is installed as an 

Administrator user.  

 

2.    Open the Add or Remove Programs window (Start > Control Panel > Add or 

Remove Programs). 

 

3.    Select Telelogic Dashboard Web Services from the list. 

 

4.    Click Remove/Uninstall. 

 

5.    Delete the WebServices folder (C:\Program Files\Telelogic\Dashboard\Webservices) 

and all of its subfolders. 

 

 

To remove Telelogic Dashboard Collector: 

 

1.    Log into the machine where Telelogic Dashboard Collector is installed as an 

Administrator user. 

 

2.    Open the Add or Remove Programs window (Start > Control Panel > Add or 

Remove Programs). 

 

3.   Select Telelogic Dashboard Collector from the list of options. 

 

4.   Click Remove/Uninstall. 

 

5.   Delete the Collector folder (C:\Program Files\Telelogic\Dashboard\Collector) 

 

6.   Delete any remaining folders for the Telelogic Dashboard installation (C:\Program 

Files\Telelogic\Dashboard) 

 

 

To remove IIS Virtual Directories: 

 

1. Log into the machine where Telelogic Dashboard Portal is installed as an 

Administrator user. 

2. Open the IIS Manager (Start > Control Panel > Administrative Tools > Internet 

Information Services (IIS) Manager) 

3. Expand the Tree until the Virtual Directories are visible 

4. Delete the Dashboard and DashboardWS virtual directories 
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Installation of 
IBM Rational 
Dashboard 

 

This section contains steps on how to complete the update from a prior version to IBM 

Rational Dashboard version 4.0.0. 

 

 

1. Perform the steps found in Section 4 Application Installation and Licensing.  Use the 

„Update Existing Database‟ functionality in the IBM Rational Dashboard 

Configuration Utility. 

 

2. Once installation is complete, copy the collector.set file saved in the Pre-Update 

Instruction section to the IBM Rational Collector installation location.  The 

collector.set file is located by default at C:\Program Files\IBM\ 

Rational\Dashboard\Collector 

 

3. Copy the .bin files saved in the Pre-Update Instruction section to the logs folder of 

the new installation.  The default location is C:\Program Files\IBM\ 

Rational\Dashboard\Portal\Logs 

 

4. Update the Portal_Location in the web services web.config (if necessary).  The 

web.config is located by default at C:\Program Files\IBM\Rational\Dashboard\ 

WebServices 
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7 Testing Installation 
 

This chapter contains the following installation testing topics: 

 

 Testing IBM Rational Dashboard Portal 

 

 Testing IBM Rational Dashboard Web Services 

 

 

Testing 
IBM Rational  
Dashboard 
Portal 

This section contains test procedures for verifying IBM Rational Dashboard Portal has been 

correctly installed and configured. 

 

To Test IBM Rational Dashboard Portal: 

 

1. Log on to the server, where IBM Rational Dashboard Portal was installed, as the 

administrator user that was used during installation, and navigate to:  http://Server 

Name/Dashboard/ 

 

2. Replace Server Name with the name of the server where IBM Rational Dashboard is 

installed. 

 

3. You should see the IBM Rational Dashboard Portal user interface screen shown below. If 

you do not see this screen, then troubleshooting steps for the installation should be taken. 

Possible errors and the steps to correct them are listed in Section 7 Troubleshoot 

Installation.  
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Testing 
IBM Rational 
Dashboard 
Web Services 

This section contains test procedures for verifying IBM Rational Dashboard Web Services 

have been correctly installed and configured. 

 

To Test IBM Rational Dashboard Web Services: 

 
1.  Log on to the server, where IBM Rational Dashboard Portal was installed, as the 

administrator user that was used during installation, and navigate to the WSAPI page by 

entering the following address into your web browser:   

        http://ServerName/DashboardWS/WSAPI.asmx 

 

2. Replace Server Name with the name of the server where IBM Rational Dashboard is 

installed. 

 

3. You should see the WSAPI screen shown below. If you do not see this screen, then 

troubleshooting steps for the installation should be taken. Possible errors and the steps to 

correct them are listed in Section 7 Troubleshooting Installation.   
  

                                 

 

    
    

http://servername/DashboardWS/WSAPI.asmx
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8 Troubleshooting Installation 
 

This chapter contains the following Installation Testing topics: 

 

 Database Not Created During Install 

 

 Server Application Unavailable 

 

 Server Error in ‘/DashboardWS’ Application 

 

 Invalid Database Connection String 

 

 The Page Cannot Be Displayed 

 

 Invalid License String 

 

 System and Application Log Files 

 

 Error Viewing Crystal Reports 

 

 

 

Database Not 
Created During 
Install  

This section contains troubleshooting information when the Database Configuration utility 

cannot create the database needed for IBM Rational Dashboard.  

 

To correct this problem, please try these steps:  

 

1. Review the Database Configuration utility log file. As the utility executes, it writes to a 

log file located in the same folder as the utility. 

The default is “C:\Program Files\IBM\Rational\Dashboard\Configuration\setup.log” 

 Using Notepad, open the setup.log file and see what has been happening. 

2. Check the SQL Server product name. If this is SQL developer, standard, or enterprise, 

then re-run the IBM Rational Dashboard Configuration utility 

(DatabaseSetup.exe) and make sure you do not set the checkbox for a named 

instance. If this is SQL Express, then start the SQL Management Console and read the 

instance name by examining the button to stop service.  

3. Make sure that the user who is running the configuration utility has create permission 

in the SQL database  
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Server 
Application 
Unavailable 

This section contains troubleshooting information when a Server Application Unavailable 

message is given. 

 

To verify ASP Framework (v2.0.50727) snap-in is installed and running in IIS: 

 

1. Check the properties for DashboardWS   

       Control Panel > Administrative Tools > Internet Information Service (IIS), right click on 

       properties.   

 

2. Verify the ASP tab is present and ASP version is set to 2.0.50727. 

 

3. If you do not see the tab and v2.0.50727, the framework is not running correctly.  

 

4. Microsoft reports this error on some servers that were running previous versions of the 

                                           framework. Take the following corrective steps: 

a.    Open regedit and backup your registry 

b.    Search for 40607 and delete the keys 

c.    Remove: HKEY_CLASSES_ROOT\CLSID\ 

             {7D23CCC6-A390-406E-AB67-2F8B7558F6F6}  

       d.    Close regedit 

       e.    Re-register ASP with aspnet_regiis –i 

 

5. Confirm in DashboardWS Properties  

Control Panel > Administrative Tools > Internet Information Service (IIS), right click on 

                                            properties.   

 

                                            ASP tab and ASP version is set to 2.0.50727 
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Server 
Error in ‘/DashboardWS’  
Application 

This section contains troubleshooting information when you try to run IBM Rational 

Dashboard Web Services and get Server Error in „/DashboardWS‟ application. 
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       To verify permissions: 

 

1. Verify permissions on the web.config file. Default IBM Rational Dashboard Web 

Services location:  C: \ Program Files\IBM\Rational\Dashboard\WebServices 

 

2. The local ASP account must have Full Control of the web.config file:  Right mouse 

click on the web.config file and select Properties > Security   

 
3.    Permissions are Allow: Full Control, Modify, Read & Execute, Read and Write. 

  

 

 
 

 

Invalid  
Database 
Connection 
String 

This section contains troubleshooting information when you get an Invalid Database 

Connection String message. 

 

To check database creation: 

  

1.    Invalid database connection string: dbtype=SQLSERVER2000; server=ServerName;  

              UID=TeleDash; PWD=TeleDashPass; database=Dashboard_01” indicates there was a  

              problem with the database creation during the install. 
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2. Check the Portal_db_create_log.txt file, created during the install, in your 

        user‟s temp directory. This file contains details about the creation of the database. 

 

3. [DBNETLIB]Specified SQL server not found.  – Indicates the Database Server was not  

found, check the name you specified during the install. Verify you are using the correct        

Server Name and Instance Name of your SQL Server. 

 

4.  Login failed for user 'TeleDash' – Indicates the „TeleDash‟ user was not created in the 

        database prior to the installation. 

 

5. Could not locate entry in sysdatabases for database 'Dashboard_01'.  – Indicates the  

       „TeleDash‟ user was not added to the Database Creators (dbcreator) role in the Database   

        Server. 

 

6. CREATE TABLE permission denied in database… - – Indicates the „TeleDash‟ user was 

        not added to the Database Creators (dbcreator) role in the Database Server. 

 

 

The Page 
Cannot Be 
Displayed 

This section contains troubleshooting information when you get The Page Cannot Be 

Displayed message. 

    

       To check IIS: 

 

1.    The Page Cannot Be Displayed message indicates there is a problem with IIS. 

 

2. Verify IIS is running: Internet Explorer: http://localhost/ 

 

3. If you get another, The Page Cannot Be Displayed error, IIS is not running. 

 

4. Reboot your machine and verify IIS is running: Internet Explorer: http://localhost/ 

 

5. If you get an Under Construction page or a login prompt then IIS is running correctly.  

                                           Navigate to the IBM Rational Dashboard Portal again. 

 

6. If you get another, The Page Cannot Be Displayed error, contact your server  

       administrator to perform further IIS diagnostic tests. 

 

 

Invalid 
License 
String 

This section contains troubleshooting information when you get the error message License 

String was found but is not valid or in the correct format. 

 

To check License String: 

1. Run the License Check Utility. The Liccheck.exe is located by default at: 

C:\Program Files\IBM\Rational\Dashboard\Licensing\Liccheck.exe 

http://localhost/
http://localhost/
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2. The utility is run on a DOS command prompt and will quickly identify whether you have 

a valid license. 

3. If you do not have a valid license, contact support to verify that you have a valid license.  

Support contact information is listed in section 9 of this document. 

              

 

System and 
Application 
Log Files 

This section contains information about the location of the System and Application files. The  
log files may contain helpful information for resolving issues with installation or operation. 

 

       To locate Log files: 

 

1.    IBM Rational Dashboard Portal System log file location: (Default Location) 

              C:\ Program Files \ IBM \ Rational \ Dashboard \ Portal \ logs \ PortalLog.txt   

 

2.    IBM Rational Dashboard Services log file location: (Default Location) 

       C:\ Program Files \ IBM\ Rational \ Dashboard \ Portal \ logs \ WSLog.txt  

        

       3.    IBM Rational Dashboard Collector log file location: (Default Location) 

              C:\  Program Files \ IBM \ Rational \ Dashboard \ Collector \ logfile.txt 

 

       4.    IBM Rational Dashboard Database Setup utility log file location: (Default Location) 

              C:\  Program Files \ IBM \ Rational \ Dashboard \ Configuration \ setup.log 

 

              

 

Error Viewing 
Crystal Reports 

This section contains troubleshooting information when you get an error message while trying 

to view the Crystal Reports on the Reports tab in IBM Rational Dashboard. 

 

 
 

       To Verify Permissions: 

 

1. Verify permissions on the Windows\temp directory 
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2. The Network Service or IIS_WPG account must have permission to this folder:  Right 

mouse click on the Temp folder and select Properties > Security 

3. Permissions are Allow: Read, Write, List Folder Contents 
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9 Un-Install IBM Rational Dashboard 
 

This chapter contains the following IBM Rational Dashboard Un-Install topics: 

 

 Un-Install IBM Rational Dashboard Portal 

 

 Un-Install IBM Rational Dashboard Collector 

 

 Un-Install IBM Rational Dashboard Web Services 

 

 Manually Remove Remaining Folders and Files 

 

 Manually Remove Remaining Start Menu Items 

 

 Remove Databases 

 

 

Caution:  Before Un-Installing, be sure to save any files that you may need after a re-installation including: the 

web.config, PortalLog.txt, WSLog.txt, logfile.txt, collection detail files and any other 

files tailored after the installation. 
 

 

Un-Install 
IBM Rational  
Dashboard 
Portal 

To remove IBM Rational Dashboard Portal: 

 

1. Log into the machine where IBM Rational Dashboard Portal is installed as an 

Administrator user. 

 

2. Start > Settings > Control Panel; Double click Add/Remove Programs. 

 

3. Select IBM Rational Dashboard Portal from the list of currently installed programs. 

 

4. Click Change/Remove. 

 

5. Click OK to un-install IBM Rational Dashboard Portal and all of its features. 
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Un-Install 
IBM Rational  
Dashboard 
Collector 

To remove IBM Rational Dashboard Collector: 

 

1. Log into the machine where IBM Rational Dashboard Collector is installed as an 

Administrator user. 

 

2. Start > Settings > Control Panel; Double click Add/Remove Programs. 

 

3. Select IBM Rational Dashboard Collector from the list of currently installed programs. 

 

4. Click Change/Remove. 

 

5. Click OK to un-install IBM Rational Dashboard Collector and all of its features. 

 

 
 

 

Un-Install 
IBM Rational  
Dashboard 
Web Services 

To remove IBM Rational Dashboard Web Services: 

 

1. Log into the machine where IBM Rational Dashboard Web Services is installed as an 

Administrator user.  

 

2. Start > Settings > Control Panel; Double click Add/Remove Programs. 

 

3. Select IBM Rational Dashboard Web Services from the list of currently installed 

programs. 

 

4. Click Change/Remove. 

 

5. Click OK to un-install IBM Rational Dashboard Web Services and all of its features. 
 

 

Manually Remove 
Remaining Folders 
And Files 

The un-install process removes any files that were placed on your system during the 

installation process.  The un-install does not remove files that were created by IBM Rational 

Dashboard through normal operation.  In addition, the un-install process does not remove files 

that you copied in manually using the Windows File Manager or another method.  

 

To manually remove remaining folders and files: 

 

1. Review all files and folders to determine whether to save the file prior to removing them.  
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2. Once you determine that they are no longer needed, the following folders may be 

removed using the Windows File Manager: (Default Location) 

 

 C:\Program Files\IBM\Rational\Dashboard, and all subfolders 

 

 
 

 

Manually Remove 
Remaining Start Menu 
Items 

To manually remove remaining Start Menu Items: 

 

1.   Start Menu > Programs > IBM > Rational, right click Dashboard folder. 

 

2.   Select Delete.   
 

 

Remove 
Databases 

To remove databases: 

 

1.    Start SQL Enterprise Manager or SQL Server Configuration Manager Utility for SQL 

       Server Express. 

 

       2.    Manually remove the “Dashboard” and “Transform” databases (default names). 
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10 Contact Information 
  

This chapter contains the following  topics: 

 

 Contacting IBM Rational Software Support 

 

 Prerequisites 

 

 Submitting problems 

 

 Other information 

 

 

 

Contacting IBM 
Rational Software 
Support 

If the self-help resources have not provided a resolution to your problem, you can contact 

IBM Rational Software Support for assistance in resolving product issues.  

 

Note: If you are a heritage Telelogic customer, you can go to 

http://support.telelogic.com/toolbar and download the IBM Rational 

Telelogic Software Support browser toolbar. This toolbar helps 

simplify the transition to the IBM Rational Telelogic product online 

resources. Also, a single reference site for all IBM Rational 

Telelogic support resources is located at 

http://www.ibm.com/software/rational/support/telelogic/ 

 

 

Prerequisites 

To submit your problem to IBM Rational Software Support, you must have an active 

Passport Advantage® software maintenance agreement. Passport Advantage is the IBM 

comprehensive software licensing and software maintenance (product upgrades and 

technical support) offering. You can enroll online in Passport Advantage from 

http://www.ibm.com/software/lotus/passportadvantage/howtoenroll.html. 

 

o To learn more about Passport Advantage, visit the Passport Advantage FAQs at 

http://www.ibm.com/software/lotus/passportadvantage/brochures_faqs_ 

quickguides.html. 

o For further assistance, contact your IBM representative. 

To submit your problem online (from the IBM Web site) to IBM Rational Software 

Support, you must additionally: 

o Be a registered user on the IBM Rational Software Support Web site. For details 

about registering, go to http://www-01.ibm.com/software/support/. 

http://www.ibm.com/software/lotus/passportadvantage/brochures_faqs_%20quickguides.html
http://www.ibm.com/software/lotus/passportadvantage/brochures_faqs_%20quickguides.html
http://www-01.ibm.com/software/support/
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o Be listed as an authorized caller in the service request tool. 

 

 

Submitting 
Problems 

To submit your problem to IBM Rational Software Support: 

 

1.   Determine the business impact of your problem. When you report a problem to IBM, 

you are asked to supply a severity level. Therefore, you need to understand and 

assess the business impact of the problem that you are reporting. 

Use the following table to determine the severity level. 

Severity Description 

1 The problem has a critical business impact: 

You are unable to use the program, resulting 

in a critical impact on operations. This 

condition requires an immediate solution. 

2 This problem has a significant business 

impact: The program is usable, but it is 

severely limited. 

3 The problem has some business impact: The 

program is usable, but less significant features 

(not critical to operations) are unavailable. 

 4 The problem has minimal business impact: 

The problem causes little impact on operations 

or a reasonable circumvention to the problem 

was implemented. 

 

2.   Describe your problem and gather background information, When describing a 
problem to IBM, be as specific as possible. Include all relevant background 
information so that IBM Rational Software Support specialists can help you 
solve the problem efficiently. To save time, know the answers to these 
questions: 

o What software versions were you running when the problem occurred? 

To determine the exact product name and version, use the option 
applicable to you:  

o Start the IBM Installation Manager and select File > View Installed 
Packages. Expand a package group and select a package to see the 
package name and version number.  

o Start your product, and click Help > About to see the offering name 
and version number. 

o What is your operating system and version number (including any service 
packs or patches)?  

o Do you have logs, traces, and messages that are related to the problem 
symptoms?  

o Can you recreate the problem? If so, what steps do you perform to 
recreate the problem?  
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o Did you make any changes to the system? For example, did you make 

changes to the hardware, operating system, networking software, or other 

system components?  

o Are you currently using a workaround for the problem? If so, be prepared to 

describe the workaround when you report the problem. 

3.   Submit your problem to IBM Rational Software Support. You can submit your 

problem to IBM Rational Software Support in the following ways: 

o Online: Go to the IBM Rational Software Support Web site at 

https://www.ibm.com/software/rational/support/ and in the Rational support task 

navigator, click Open Service Request. Select the electronic problem reporting 

tool, and open a Problem Management Record (PMR), describing the problem 

accurately in your own words. 

For more information about opening a service request, go to 

http://www.ibm.com/software/support/help.html 

You can also open an online service request using the IBM Support Assistant. 

For more information, go to http://www-

01.ibm.com/software/support/isa/faq.html. 

o By phone: For the phone number to call in your country or region, go to the 

IBM directory of worldwide contacts at http://www.ibm.com/planetwide/ and 

click the name of your country or geographic region.  

o Through your IBM Representative: If you cannot access IBM Rational 

Software Support online or by phone, contact your IBM Representative. If 

necessary, your IBM Representative can open a service request for you. You can 

find complete contact information for each country at 

http://www.ibm.com/planetwide/. 

 

If the problem you submit is for a software defect or for missing or inaccurate 

documentation, IBM Rational Software Support creates an Authorized Program Analysis 

Report (APAR). The APAR describes the problem in detail. Whenever possible, IBM 

Rational Software Support provides a workaround that you can implement until the 

APAR is resolved and a fix is delivered. IBM publishes resolved APARs on the IBM 

Rational Software Support Web site daily, so that other users who experience the same 

problem can benefit from the same resolution. 

 

 

 

Other 
Information 

For Rational software product news, events, and other information, visit the IBM 

Rational Software Web site on http://www.ibm.com/software/rational/. 

 

http://www.ibm.com/planetwide/


 
© Copyright IBM Corp. 2004, 2009   

 

 

|79 

 
 
 

 

11 Notices 
 
This information was developed for products and services offered in the U.S.A.  IBM may not offer the products, 

services, or features discussed in this document in other countries. Consult your local IBM representative for 

information on the products and services currently available in your area. Any reference to an IBM product, 

program, or service is not intended to state or imply that only that IBM product, program, or service may be used. 

Any functionally equivalent product, program, or service that does not infringe any IBM intellectual property right 

may be used instead. However, it is the user's responsibility to evaluate and verify the operation of any non-IBM 

product, program, or service.   

 

IBM may have patents or pending patent applications covering subject matter described in this document. The 

furnishing of this document does not grant you any license to these patents. You can send written license inquiries 

to: 

 

IBM Director of Licensing 

IBM Corporation 

North Castle Drive 

Armonk, NY 10504-1785 

U.S.A. 

 

For license inquiries regarding double-byte character set (DBCS) information, contact the IBM Intellectual Property 

Department in your country or send written inquiries to: 

 

IBM World Trade Asia Corporation 

Licensing 

2-31 Roppongi 3-chome, Minato-ku 

Tokyo 106-0032, Japan 

 

The following paragraph does not apply to the United Kingdom or any 

other country where such provisions are inconsistent with local law: 

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION “AS IS” 

WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT 

LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR 

FITNESS FOR A PARTICULAR PURPOSE. 

 
Some states do not allow disclaimer of express or implied warranties in certain transactions. Therefore, this 

statement may not apply to you.   

 

This information could include technical inaccuracies or typographical errors.  Changes are periodically made to the 

information herein; these changes will be incorporated in new editions of the publication. IBM may make 

improvements and/or changes in the product(s) and/or the program(s) described in this publication at any time 

without notice.   

 

Any references in this information to non-IBM Web sites are provided for convenience only and do not in any 

manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of the materials for 

this IBM product and use of those Web sites is at your own risk.  IBM may use or distribute any of the information 

you supply in any way it believes appropriate without incurring any obligation to you.   
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Licensees of this program who wish to have information about it for the purpose of enabling: (i) the exchange of 

information between independently created programs and other programs (including this one) and (ii) the mutual use 

of the information which has been exchanged, should contact: 

 

Intellectual Property Dept. for Rational Software 

IBM Corporation 

1 Rogers Street 

Cambridge, Massachusetts 02142 

U.S.A. 

 

Such information may be available, subject to appropriate terms and conditions, including in some cases, payment of 

a fee.   

 

The licensed program described in this document and all licensed material available for it are provided by IBM 

under terms of the IBM Customer Agreement, IBM International Program License Agreement or any equivalent 

agreement between us.   

 

Any performance data contained herein was determined in a controlled environment. Therefore, the results obtained 

in other operating environments may vary significantly. Some measurements may have been made on development-

level systems and there is no guarantee that these measurements will be the same on generally available systems. 

Furthermore, some measurements may have been estimated through extrapolation. Actual results may vary. Users of 

this document should verify the applicable data for their specific environment.   

 

Information concerning non-IBM products was obtained from the suppliers of those products, their published 

announcements or other publicly available sources. IBM has not tested those products and cannot confirm the 

accuracy of performance, compatibility or any other claims related to non-IBM products.  Questions on the 

capabilities of non-IBM products should be addressed to the suppliers of those products. 

 

This information contains examples of data and reports used in daily business operations. To illustrate them as 

completely as possible, the examples include the names of individuals, companies, brands, and products. All of these 

names are fictitious and any similarity to the names and addresses used by an actual business enterprise is entirely 

coincidental.  If you are viewing this information softcopy, the photographs and color illustrations may not appear. 

 

Trademarks 
IBM, the IBM logo, ibm.com, DOORS, Passport Advantage, and Rational are trademarks or registered trademarks 

of International Business Machines Corp., registered in many jurisdictions worldwide. Other product and service 

names might be trademarks of IBM or other companies. A current list of IBM trademarks is available on the Web at 

www.ibm.com/legal/copytrade.html. 

 

Intel, Intel logo, Intel Inside, Intel Inside logo, Intel Centrino, Intel Centrino logo, Celeron, Intel Xeon, Intel 

SpeedStep, Itanium, and Pentium are trademarks or registered trademarks of Intel Corporation or its subsidiaries in 

the United States and other countries. 

 

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation in the United 

States, other countries, or both. 

 

Other company, product or service names may be trademarks or service marks of others. 

 

 

http://www.ibm.com/legal/copytrade.html

